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Before you Begin 

_________________________________ 
The JADE Parsys Application User’s Guide is intended as the main source of information when 
you want to search for, add, update, or view fault reports for your Jade Software Corporation 
Limited-supplied software product. 

What you Need to Know 
You should be familiar with: 

� Operational concepts of IBM-compatible PCs. 

� Microsoft Windows 2003 Server, Windows XP, or Windows 2000. 

� Operational concepts of using a standard spell-checking dialog. 

What's Included in this Guide  
The JADE Parsys Application User's Guide has the two chapters and one appendix, which are 
listed in the following table. 

Chapter 1 Provides instructions for signing on and off, general use of the Parsys 
application (Parsys/cnwpucf), and using the online product information. 

Chapter 2 Provides instructions about searching for existing contacts and adding and 
updating contacts. 

Appendix A Provides instructions for installing Parsys, automatically upgrading software, 
and connectivity troubleshooting. 

Although this PDF file is compatible with Adobe Reader versions 5.0 through 7.0, we 
recommend you use Adobe Reader 8.0 as it offers advanced functionality and may reduce 
printing problems in some situations.   

You can download and install the free Adobe Reader version 8.0 from the Adobe Web site 
(www.adobe.com).  Select the Get Adobe Reader icon on the Adobe Home page. 

http://www.adobe.com/
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A Note on User Interfaces 
You can select various options (or skins) to customise your own user interface.  The screen shots 
used for illustration in this documentation do not always reflect the look and feel of the user 
interface that your organisation has chosen.   

The JADE Parsys Application User's Guide uses a generic version of the user interface to 
illustrate functionality. 

Conventions  
The JADE Parsys Application User's Guide uses consistent typographic conventions throughout. 

Convention Description 
Arrow bullet (¾) Step-by-step procedures.  You can complete procedural instructions by 

using either the mouse or the keyboard. 
Bold File names, menu commands, and form fields, as well as literal values 

stored, tested for, and sent by Parsys. 
Italic Parameter values or placeholders for information that must be provided; 

for example, if instructed to enter user-code, type your actual user code 
instead of the word or words shown in italic type. 

 Italic type also signals a new term.  An explanation accompanies the 
italicized type. 

 Document titles and status and error messages are also shown in italic 
type. 

Bright blue text Enables you to click anywhere on the cross-reference text (the cursor 
symbol changes from an open hand to a hand with the index finger 
extended) to take you straight to that topic.  For example, click on the 
“Using the Menus” cross-reference to display that topic. 

Bracket symbols ( [ ] ) Indicate optional items. 
Vertical bar ( | )  Separates alternative items. 
Monospaced font Syntax, code examples, and error and status message text. 
ALL CAPITALS Directory names, commands, and acronyms. 
SMALL CAPITALS Keyboard keys. 

Key combinations and key sequences appear as follows. 

Convention Description 
KEY1+KEY2 Press and hold down the first key and then press the second key.  For 

example, “press SHIFT+F2” means to press and hold down the SHIFT key 
and press the F2 key.  Then release both keys. 

KEY1,KEY2 Press and release the first key, then press and release the second key.  For 
example, “press ALT+F,X” means to hold down the ALT key, press the F 
key, and then release both keys before pressing and releasing the X key. 
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The terms used in this document are listed in the following table. 

Term Description 
Contact A fault report or a query that you initiate in Parsys.   
PAR Product Anomaly Report (PAR).  When product support cannot directly answer 

your question, your contact is converted to a PAR for assigning to the appropriate 
product plant. 

Product The software product that you have purchased from Jade Software Corporation 
Limited; for example, JADE, JADE Master Terminal, JADE Student Management 
System, JADE Co-ordinated Care, JADE Star, and so on. 
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Chapter 1    Getting Started 

________________________________  
This chapter covers the following topics. 

� Overview 

� Signing On and Off 

� Signing On to the Parsys Application 

� Signing Off from the Parsys Application 

� Logging Off from the Parsys Application 

� Changing Your Password 

� Using the Parsys Application 

� Navigating Around the Parsys Application 

– Using the Menus 

– Using Function Keys and Shortcut Keys 

– Changing Your View of Parsys 

� Phases of a Contact 

� Displaying Parsys Version Information 
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Overview 
The Parsys application (Parsys/cnwpucf) manages product fault reports and queries for Jade 
Software Corporation Limited products by: 

� Ensuring that all fault reports or queries are assigned a unique number for future reference.   

Note   The number that is assigned is unique to that product only; that is, it may be used 
for other JADE products. 

� Ensuring that all relevant software release details are entered.   

� Ensuring a brief and a full description of the fault is entered.  

� Allowing attachment of any supporting material such as application logs.  

� Allowing easy identification of the client reporting the fault or query.  

If you have the appropriate permission, you can access Parsys on the managed server over a 
remote connection and view or maintain all contacts for which you have permission.   

As a client user, you initiate a fault or query (known in Parsys as a contact), which then goes 
through a number of phases, including the following. 

� Initial investigation by the support staff for the product against which you opened the 
contact. 

� Provision of an answer directly by the support staff. 

� Opening of a Product Anomaly Report (PAR) to the appropriate product plant within Jade 
Software Corporation Limited for further investigation. 

Signing On and Off 
This section covers the following topics. 

� Signing On to the Parsys Application 

� Signing Off from the Parsys Application 

� Logging Off from the Parsys Application 

For details, see the following subsections.  (For details about installing the Parsys application 
and automatically upgrading software, see “Installing the Parsys Application” and 
“Automatically Upgrading Software”, in Appendix A.) 

Signing On to the Parsys Application 
¾ To initiate the Parsys application 

� Select the Parsys icon (the program shortcut) on your desktop so that it is highlighted and 
then press the ENTER key.   

Alternatively, double-click on the Parsys icon. 
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When you have started the Parsys application, the start-up form is displayed while the software 
initialises and a connection is made to the application server workstation on which the Parsys 
database is located.  

Note   You are required to reset your password the first time you sign on to the Parsys 
application, as the one that enables you to access the application initially was set by someone 
other than you. 

When Parsys has started, the sign-on form shown in the following diagram is then displayed.  

 

¾ To sign on to the Parsys application 

1. In the Usercode text box, enter your Parsys user-code.   

The user code is case-insensitive. 

2. In the Password text box, enter the password associated with your user code.  As this is a 
hidden text box for security reasons, each character is represented by an asterisk (*).   

The password is case-sensitive. 

If you have forgotten your password or you exceed the permitted number of password 
attempts so that you are then unable to sign on to Parsys, contact your Parsys administrator, 
who will reset your password and enable your access to the system.  (You will have to reset 
your password immediately after you have signed on with your newly allocated password.) 

3. Click the OK button.  Alternatively, click the Cancel button to abandon your entries. 

When you enter a valid user code and password combination, the Parsys background window is 
then displayed.  For details, see “Using the Parsys Application” and “Navigating Around the 
Parsys Application”, later in this chapter.   

See also “Signing Off from the Parsys Application” or “Logging Off from the Parsys 
Application”, in the following sections. 
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Signing Off from the Parsys Application 
¾ To exit from the Parsys application, perform one of the following actions 

� Select the Exit command from the File menu.  

� Click the close icon (⌧) at the top right corner of the window. 

� Select the Close command from the Control-Menu (that is, the icon at the top left corner of 
the window). 

� Press ALT+F4. 

The Parsys application is then closed down. 

Logging Off from the Parsys Application 
¾ To log off from the Parsys application 

� Select the Logoff command from the File menu. 

The Parsys application is then closed down and the sign-on form is displayed again, to enable 
you to sign on as a different user.  (For details, see “Signing On to the Parsys Application”, 
earlier in this chapter.) 

Changing Your Password 
You can change you password for Parsys at any time.  If you think that someone else knows 
your password, you should change it as soon as possible.  In addition, we recommend that you 
change your password regularly. 

¾ To change your password 

1. Select the Change Password command from the File menu.   

The Change Password form, shown in the following diagram, is then displayed.   
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2. Enter your current password in the Old Password field.   

The current password is case-sensitive. 

Note   As this is a hidden field for security reasons, each character is represented by an 
asterisk character (*).   

3. Enter your new password in the New Password field.   

The new password is case-sensitive. 

4. Re-enter your new password in the Repeat New Password field. 

5. Click the OK button.  Alternatively, click the Cancel button to abandon your entries. 

Your password is then updated. 

Using the Parsys Application 
This section covers the following topics. 

� Navigating Around the Parsys Application 

� Using the Menus 

� Using Function Keys and Shortcut Keys 

� Changing Your View of Parsys 

� Phases of a Contact 

� Displaying Parsys Version Information 

For details, see the following subsections. 

Navigating Around the Parsys Application 
The Parsys background window is opened when you sign on to the Parsys application.  
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The following diagram shows the Parsys background window that is displayed when you sign on 
to Parsys for the first time. 

 
If you had forms open when you last logged off from Parsys, they are reopened and restored to 
their previous positions when you next logon to Parsys.   

Navigate to functions in Parsys by using: 

� Menu commands (for details, see “Using the Menus”, later in this chapter) 

� Tabs on tables when you have a form with a table displayed 

Using the Menus 
The menus (and the commands in menus) that are displayed at any time depend on your level of 
access to Parsys.  For example, you can access the Administration menu only if you have the 
appropriate administrative level of permission. 

Note   Menu commands that are not available for selection are greyed out or not visible.  

¾ To access a menu 

� Select the required menu.   

A drop-down list is then displayed, showing the commands that are available in that menu.   
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You can use the menus listed in the following table in Parsys. 

Menu Provides access to commands so that you can… 
File Exit or log off from the Parsys application, set user preferences, and 

change your password 
News Information such as scheduled outages, past and pending for Parsys 
Client Open a new contact and list your open contacts and PARs 
Search Perform searches using keywords and other user-specified criteria 
Hot Fixes Download hot fixes for supported product releases 
Window Display open forms, tile open forms, and list open forms 
Help Access information about the version of Parsys 

For details, see the following subsections.   

File Menu 
The File menu provides the commands listed in the following table, which enable you to 
maintain your user password, exit from, and log off from the Parsys application. 

Command For details, see… 
Change Password Changing Your Password, earlier in this chapter 
Logoff Logging Off from the Parsys Application, earlier in this chapter 
Exit Signing Off from the Parsys Application, earlier in this chapter 

News Menu 
The News menu provides information about Parsys; for example, updates of past and scheduled 
outages. 

Client Menu 
The Client menu provides the commands listed in the following table, which enable you to open 
a new contact or list your open contacts and PARs.  

Command  Enables you to… 
Open Contact  Open a new contact for one of your products 
List my open Faults & Contacts  List your open faults and contacts in Parsys 

For details, see “Maintaining Contacts” and “Searching for, Viewing, and Printing a Contact or 
PAR”, in Chapter 2.   

See also “Applying a Skin to Change the Parsys Window Appearance” under “Changing Your 
View of Parsys”, later in this chapter. 
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Search Menu 
The Search menu opens the search form, which enables you to search for existing contacts and 
PARs by keyword and other criteria.   

For details, see “Searching for Other Users’ Contacts and PARs”, in Chapter 2. 

Hot Fixes Menu 
The Hot Fixes menu enables you to download hot fixes for supported product releases.   

Command Enables you to… 
Hot Fixes  List available hot fixes for supported product releases 

Window Menu 
The Window menu provides the commands listed in the following table, which enable you to 
specify the display of forms and view windows on your workstation monitor or desktop.  

Command Enables you to… 
Arrange Icons Arrange all minimised form icons in an orderly manner in the 

lower area of the Parsys background window 
Cascade Arrange open forms in an overlapping pattern so that the title 

bar of each form remains visible 
Tile Horizontal Tile all open windows horizontally  
Tile Vertical Tile all open windows vertically 

The lower portion of the Window menu lists all currently open forms in the order in which they 
were opened.  The current (active) form is indicated by a check mark symbol (9) to the left of 
the form name. 

Help Menu 
The Help menu provides the command listed in the following table, which enables you to access 
Parsys version information.  

Command Opens the … 
About About Parsys form, which provides version and copyright information about 

the Parsys application.  (For details, see “Displaying Parsys Version 
Information”, later in this chapter.) 
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Using Function Keys and Shortcut Keys 
You can use the keyboard to perform functions in Parsys.  For example, you can: 

� Use the TAB key to move the cursor to the next control in a form or a table cell. 

� Use the HOME key to move the cursor to the start of the current control or to the top of a 
table column. 

� Use the END key to move the cursor to the end of the current control or to the bottom of a 
table column on a form. 

� Use the CTRL+F6 keys to cycle through all open forms (that is, hold down the CTRL key 
and press the F6 key).   

Alternatively, to activate an open form, select the appropriate form from the list in the 
Window menu.   

� Use the ALT+TAB keys to cycle through all open applications (that is, hold down the ALT 
key and press the TAB key). 

� If the cursor is positioned in the row of a table or in a form control that contains a list, use 
the up arrow (↑) or the down arrow (↓) to move your selection to the next row up or down 
the table or to select the previous or next item in the list, respectively. 

� Use a shortcut key listed in the following table to drop down the appropriate menu, and 
then use the → arrow to open a submenu, or the ↑ arrow or the ↓ arrow to move your 
selection up or down the menu commands. 

Key Combinations Drops down the … 
ALT+F File menu 
ALT+N News menu 
ALT+C Client menu 
ALT+S Search form 
ALT+O Hot Fixes menu 
ALT+W Window menu  

ALT+H Help menu 

Use the keyboard to select a menu command when a menu is dropped down, by pressing 
the key that corresponds to the underlined character in the command that you want to 
select.   

� Use a shortcut key listed in the following table to perform insert and delete functions in a 
control by using the keyboard. 

Key Function 
BACKSPACE Deletes the character to the left of the cursor 
DEL Deletes the character to the right of the cursor 
INSERT Toggles the insert mode on or off 
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� Use a shortcut key to action a click of a button on a form, by pressing the ALT key and the 
appropriate shortcut (underlined) key to action that button.  

� Use a combo box to perform one of the following actions. 

� Click the  symbol at the right of the control, and then select the required value from 
the list that is displayed. 

� Type your data in the text area.   

The entry in the control list that is alphabetically equal to or greater than the text that 
you enter is selected.  You therefore only have to enter as much text as required to 
uniquely identify a specific entry.  

Changing Your View of Parsys 
Parsys provides you with the commands that enable you to change the appearance of Parsys 
during your work sessions.   

These changes are described in the following subsection. 

Applying a Skin to Change the Parsys Window Appearance 
You can change the appearance of the Parsys background window and all forms that are 
displayed, by applying a skin.   

Skins are a series of images that are applied to the caption line, menu line, and border areas of 
each form to provide an enhanced look and feel to each form.   

Some skins can also change the appearance of images for button, check box, and option button 
controls.   

Note   The application of a skin applies only to your view of Parsys and it is retained for future 
work sessions or until you change it. 

¾ To select a skin to change your view of Parsys 

1. Select the User Preferences command from the File menu.   

The User Preferences form is then displayed. 

2. Click on the Look & Feel tab.   
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The Look & Feel sheet, shown in the following diagram, is then displayed. 

 

Note   Not all options displayed on this form are applicable to a client user. 

3. Select the required skin in the skin selection combo box. 

The skin that you select is immediately applied to the background window and any forms 
that are currently displayed. 

4. Repeat step 3 until you have applied the skin that you desire for your Parsys work sessions. 

5. Click the Update button to save your user preferences.  Alternatively, click the close icon 
( ) at the top right corner of the form to abandon your selections. 
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¾ To turn off the display of a skin 

1. Select the User Preferences command from the File menu.   

The User Preferences form is then displayed. 

2. Click on the Look & Feel tab.   

The Look & Feel sheet is then displayed. 

3. Select <none> in the skin selection combo box. 

The skin is then removed from the background window and any forms that are currently 
displayed. 

Note   Not all of the options displayed on this dialog are applicable to a client user. 

4. Click the Update button to save your user preferences.   

Phases of a Contact 
A contact can pass through several phases, from your initial opening of the contact to the closure 
of the contact or the PAR. 

Phase Description  
Contact Initial reporting of a problem, new feature suggestion, or 

documentation issue 
PAR Used to pass problem onto the development staff for further 

investigation 
Qualification Used by qualification staff to record the results of testing 
Documentation Used by documentation staff to record changes to the documentation 
Approval for release Used by the development manager to indicate that a patch is 

available for release 
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Displaying Parsys Version Information 
¾ To display version information for the Parsys application  

� Select the About Parsys command from the Help menu. 

The Parsys About form, shown in the following diagram, then displays information about the 
version of the Parsys application that you are running and copyright information.   

 
To close the Parsys About form, click the Close button. 

http://www.adobe.com/
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Chapter 2    Maintaining Contacts 

________________________________  
This chapter covers the following topics. 

� Maintaining Contacts 

� Overview 

� Adding a Contact 

� Updating a Contact 

� Closing a Contact 

� Reopening a Contact 

� Adding a Conversation Entry 

� Searching for, Viewing, and Printing a Contact or PAR 

� Searching for Your Open Contacts and PARs 

� Searching for Other Users’ Contacts and PARs 

� Viewing a Contact or PAR 

� Printing a Contact or PAR 



JADE Parsys Application 
User’s Guide 

Chapter 2    Maintaining Contacts  22 

ParsysUG-2.3 

Maintaining Contacts 
This section covers the following topics   

� Overview 

� Adding a Contact 

� Updating a Contact 

� Closing a Contact 

� Reopening a Contact 

� Adding a Conversation Entry 

Overview 
As a client user, you can add, update, and reopen a contact before it is converted to a PAR.   

After a contact has been converted to a PAR, you can continue to add conversation entries to the 
contact details if additional information becomes available for that contact.   

You can add a conversation entry to respond to a request for additional information by the Jade 
Software Corporation development group responsible for the product against which you have 
opened this contact or PAR.   

You can also add conversation entries if you want to dispute a PAR closure reason.  For details, 
see “Adding a Conversation Entry”, later in this chapter.  

Adding a Contact 
Use the Add New Contact form to add a new contact for any of the Jade Software Corporation 
products that have been made available to you in Parsys.   

¾ To add a new contact 

1. Select the Open Νew Contact command from the Client menu.   
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The Add New Contact form, shown in the following diagram, is then displayed. 

 
2. Select the appropriate product from the Product combo box. 

3. In the Contact Type combo box, select the contact type of Contact, Documentation 
Fault, Fault, or New Feature Suggestion, to specify the type of contact that you want to 
initiate.   

� The Contact option enables you to ask a general question about the product.  

� The Fault option enables you to specify a potential fault with the product. 

� The Documentation Fault option enables you to specify a problem with the 
documentation for the product. 

� The New Feature Suggestion option enables you to specify a new feature suggestion 
for the product. 

4. Select the appropriate priority in the Priority combo box.  Use a priority of A for contacts 
of high importance, B for contacts of medium importance, or C for contacts of low 
importance. 
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5. Enter your own reference in the Customer Ref text box, if required.  This text box is built 
into the keywords for this contact, for ease of subsequent searching for this contact using 
your own reference. 

6. The Updater and Client combo boxes default to display your user and organisation details.  
Select different entries, if required.   

Note   The e-mail address of the user that you select is displayed in the Email Response 
To field at the bottom of the form. 

7. Select the release number of the product in the Release combo box. 

8. Select the operating system on which you are running your product in the Client, App 
Server and Server O/S combo boxes. 

9. Select the contact topic in the Topic combo box. 

10. Enter a meaningful brief description of the problem in the Description field. 

11. Enter a full description of the problem in the New Entry field. 

12. If you have any supporting files for this problem (for example, application logs), select the 
Attached Files tab and click the Attach button, to locate and select the zip file containing 
these files. 

� Files must be zipped prior to attaching them.  You should generally zip all related 
files into one zip file. 

� Files are not copied to Parsys at this time but are marked for copying when you click 
the Update Contact button. 

� If you subsequently realise that you attached the wrong files or you do not want to 
attach any files, check the option in the Select column of the Attached Files table and 
click the Delete Selected button.   

The files will be removed, or not attached if they were added in the same update. 

13. If you want to receive an e-mail confirmation when your contact is added: 

a. Check the Email Response check box. 

b. Select your e-mail address from the Email Address combo box or if your e-mail 
address is not currently listed, enter your e-mail address in the Email Address to 
field. 

14. Click the Update Contact button to add your new contact.  Alternatively, click the close 
icon (⌧) at the upper right of the form to abandon your entries. 

Parsys validates your input and (assuming that all the required values have been filled) will 
successfully open your contact.   
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If you have any incorrectly spelled words or unrecognised words, the Check Spelling form, 
shown in the following diagram, is displayed.   

 
Use this form in the normal manner, to check the spelling of your input. 

When your contact has successfully been added, the Maintain Contact form displays your 
detailed description of the problem in the Prior Entries table, along with an indication of the 
date and time the entry was made and by whom.  The caption line indicates the unique contact 
number for this product, for future reference. 

Updating a Contact 
You can add additional conversation entries to a contact while it remains a contact and after it 
has been converted to a PAR. 

¾ To update a contact 

1. On the Search Parsys Database form, select the contact that you want to update.   

For details about locating the contact that you want to update, see “Searching for, Viewing, 
and Printing a Contact or PAR”, later in this chapter.   

2. Click the Update button on the Search Parsys Database form.   

The Maintain Contact form is then displayed, showing the details for the selected contact 
including all prior entries.  

3. Adjust any of the general details (for example, contact type, priority, release, and so on), 
as required.   

For more details, see steps 3 through 10 in “Adding a Contact”, earlier in this chapter. 
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4. Enter any additional details in the New Entry text box. 

� If you have any additional files, select the Attached Files tab and click the Attach 
button to select the required zip file and attach it (choosing whether or not to retain 
existing files, as appropriate). 

5. If you want to receive an e-mail confirmation of your changes, check the Email Response 
check box. 

Note   You can adjust the e-mail address by selecting an appropriate entry or by entering a 
new e-mail address in the Email Address combo box. 

6.  Click the Update Contact button.   

If you have any incorrectly spelled words or unrecognised words, the Check Spelling form, 
shown in the following diagram, is then displayed. 

 
Use this form in the normal manner, to check the spelling of your input. 

When the contact has successfully added, the Maintain Contact form displays your detailed 
description of the problem in the Prior Entries table, along with an indication of the date and time 
the entry was made and by whom. 
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An example of the Maintain Contact form for an updated contact is shown in the following 
diagram. 

 

Closing a Contact 
You can close a contact that you have opened at any time prior to it being converted to a PAR. 

¾ To close a contact 

1. On the Search Parsys Database form, select the contact that you want to close.   

For details about locating the contact that you want to update, see “Searching for, Viewing, 
and Printing a Contact or PAR”, later in this chapter.   

2. Click the Update button on the Search PAR Database form.   
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The Maintain Contact form (shown in the following diagram) is then displayed, showing 
the details for the selected contact, including all prior entries. 

 
3. Adjust any of the general details (for example, contact type, priority, release, and so on), as 

required.  For more details, see steps 3 through 10 in “Adding a Contact”, earlier in this 
chapter. 

4. Enter any additional details in the New Entry field.  If you have any additional files, click 
the Attach File(s) button, to select the required zip file and attach it (choosing whether or 
not to retain existing files, as appropriate). 

5. If you want to receive an e-mail confirmation of your changes, check the Email Response 
check box. 

Note   You can adjust the e-mail address by selecting an appropriate entry or by entering a 
new e-mail address in the Email Address combo box. 

6. Click the Close Contact button.  If you have any incorrectly spelled words or unrecognised 
words, the Check Spelling form is then displayed.  Use this form in the normal manner to 
check the spelling of your input. 
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When the contact is updated, the Maintain Contact form displays your additional details in the 
Prior Entries table, along with an indication of the date and time the entry was made and by 
whom.  The text Contact closed is automatically added to your entry. 

An example of the Maintain Contact form for a closed contact is shown in the following 
diagram. 

 

Reopening a Contact 
You can reopen a contact that was closed without being converted to a PAR. 

¾ To reopen a contact 

1. On the Search Parsys Database form, select the contact that you want to reopen.  For 
details about locating the contact that you want to reopen, see “Searching for, Viewing, and 
Printing a Contact or PAR”, later in this chapter.   

2. Click the Update button on the Search Parsys Database form.  The Reopen Contact form is 
then displayed, showing details for this contact. 
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3. Click the Update & Reopen button.  The Reopen Contact form, shown in the following 
diagram, is then displayed. 

 
4. Enter your reopen details into the New Entry field. 

5. Click the Update & Reopen button.  Alternatively, close the form to abandon your entries.   

If you have any incorrectly spelled words or unrecognised words, the Check Spelling form 
is then displayed.   

Use this form in the normal manner, to check the spelling of your input. 

When the contact has successfully reopened, the Maintain Contact form displays your additional 
details in the Prior Entries table, along with an indication of the date and time the entry was 
made and by whom. 
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An example of the Maintain Contact form for a reopened contact is shown in the following 
diagram. 

 

Adding a Conversation Entry 
You can add a conversation entry to a contact that you opened after it has been converted to a 
PAR. 

¾ To add a conversation entry 

1. On the Search Parsys Database form, select the contact to which you want to add a 
conversation entry.   

For details about locating the contact that you want to reopen, see “Searching for, Viewing, 
and Printing a Contact or PAR”, later in this chapter.   

2. Click the Update button on the Search Parsys Database form.   

The Add Conversation Entry form is then displayed, showing details for this contact. 
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An example of the Add Conversation Entry form for a PAR is shown in the following 
diagram. 

 
3. Enter the additional details into the New Entry field.   
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As you type, the Update – Add Conversation button becomes enabled, as shown in the 
following diagram. 

 
4. Click the Update – Add Conversation button, to update the details.  Alternatively, close 

the form to abandon your entries. 

If you have any incorrectly spelled words or unrecognised words, the Check Spelling form 
is then displayed.   

Use this form in the normal manner, to check the spelling of your input. 

The Add Conversation Entry form is automatically unloaded on successful update of the new 
information.   

If the Update form is still open, it is automatically updated with the new details displayed on the 
Contact Details sheet.  Alternatively, you can open the Update form again by performing 
another search.  For more details, see “Searching for, Viewing, and Printing a Contact or PAR”, 
later in this chapter. 
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Searching for, Viewing, and Printing a Contact or PAR 
As a client user, you can search for all of the contacts that you have opened and for all PARs that 
have been opened by other clients.  However, you cannot view contacts for other clients or see 
the contact details for a PAR that was opened by another client. 

This section covers the following topics.   

� Searching for Your Open Contacts and PARs 

� Searching for Other Users’ Contacts and PARs 

� Viewing a Contact or PAR 

� Printing a Contact or PAR 

Searching for Your Open Contacts and PARs 
¾ To search for your open contacts and PARs 

� Select the List My Open Contacts & PARs command from the Search menu. 

Note   This automatically selects the appropriate options to list your open contacts and 
PARs for your default product.   

The Search PAR Database form, shown in the following diagram, is then displayed.  
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Click on a contact that is listed in the table in the lower half of the form, to update or view 
contact details.  For details, see “Updating a Contact” and “Viewing a Contact or PAR”, 
elsewhere in this chapter. 

Searching for Other Users’ Contacts and PARs 
¾ To search for other users’ contacts and PARs 

1. Select the Advanced Search command from the Search menu.  

The Search Parsys Database form, shown in the following diagram, is then displayed.   

 
This form has three additional sheets, to enable you to perform a more-advanced search, if 
required. 

2. Select the product for which you want to perform a search, in the Product combo box. 

3. Select the mode of search you want to perform, by clicking the required option button in 
the Mode group box.  Select the: 

� Keywords option button, to specify one or more keywords for the search.  If you 
select this option button, you must complete steps 4 and 5 of this instruction. 

� Latest option button, to view the 100 most-recent contacts or PARs that match your 
search criteria.  If you select this option button, go to step 6 of this instruction. 
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� Today Only option button, to view the contacts or PARs that match your search 
criteria and that were updated today.  If you select this option button, go to step 6 of 
this instruction.   

4. If applicable, select the required keyword mode, by using the option buttons in the 
Keyword Criteria group box.  If you select the: 

� AND option button, the contact or PAR must have all of the specified keywords 
present 

� OR option button, the contact or PAR must have at least one of the specified 
keywords present 

� NOT option button, the contact or PAR must contain the first specified keyword and 
none of the other keywords 

5. If applicable, enter the keyword (or keywords) for which you want to search. 

Tips   For AND and OR searching, partial words are matched.   

For NOT searching, only the first word uses partial matching.  All subsequent words use 
exact match only. 

To search for a specific number, enter the required number preceded by a # character; for 
example, #12345. 

6. Select the contact or PAR priorities for which you want to search from the Priority list. 

7. Select the type of contact or PAR for which you want to search, by checking the required 
check boxes in the Type group box. 

8. Select the contact or PAR status for which you want to search, by checking the required 
check box and making a selection in the list box below.  You can restrict your search more, 
by using the Advanced Search Criteria I, Advanced Search Criteria II, and Advanced 
Search Criteria III sheets. 

9. To further restrict your search criteria, click on the Advanced Search Criteria I tab and 
then perform the following actions.  When you click on the Advanced Search Criteria I 
tab, the Advanced Search Criteria I, sheet, shown in the following diagram, is then 
displayed. 

 
a. To restrict the search to only your contacts and PARs, select your client name in the 

Client list box and deselect the All option. 
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b. To restrict the search to only selected topics, select all the required topics in the Topic 
list box and deselect the All option. 

You can further restrict the search criteria, by using the optional Advanced Search 
Criteria II sheet on the search form. 

10. To further restrict your search criteria, click on the Advanced Search Criteria II tab and 
then perform the following actions.  When you click on the Advanced Search Criteria II 
tab, the Advanced Search Criteria II sheet, shown in the following diagram, is then 
displayed. 

 
a. In the Par reopened at least x times text box, enter a value greater than zero (0) for 

the number of times the PAR has been reopened. 

b. In the Has at least x duplicates text box, enter a value greater than zero (0) for the 
number of duplicate PARs. 

c. Check the A hot fix was created check box, to select only PARs for which a hot fix 
was created. 

d. In the Assignee list box, select Unassigned to show only unassigned PARs or only 
PARs assigned to specific developers, by deselecting the All option and then selecting 
the required developers or Unassigned options. 

You can further restrict the search criteria, by using the optional Advanced Search 
Criteria III sheet on the search form. 

11. To further restrict your search criteria, click on the Advanced Search Criteria III tab and 
then perform the following actions.  When you click on the Advanced Search Criteria III 
tab, the Advanced Search Criteria III sheet, shown in the following diagram, is then 
displayed. 

 
a. To restrict the search to only selected releases opened, select all of the required 

opened releases in the Opened list box and deselect the All option. 
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b. To restrict the search to only selected releases scheduled, select all the required 
scheduled releases in the Scheduled list box and deselect the All option.  (Note that 
this option applies only to PARs that have been patched.) 

c. To restrict the search to only selected releases that have been closed, select all of the 
required closed releases in the Closed list box and deselect the All option. 

d. To restrict the search to selected releases qualified only, select all of the required 
qualified releases in the Qualified list box and deselect the All option.  (Note that this 
option applies only to PARs that have been patched.) 

e. In the Date Range – Opened fields, enter a From date, a To date, or both, to filter by 
date opened.   

f. In the Date Range – Closed fields, enter a From date, a To date, or both, to filter by 
date opened. 

12. Click the Search button, to perform the search using your selection criteria. 

When the search has completed, the search form is displayed showing the results of your search. 

You can display a colour legend, which displays details abut the colours assigned to different 
kinds of contacts and PARs.  For details, see “Viewing the Colour Legend for the PAR Search 
Forms”, later in this chapter. 
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Tip   Some words are deliberately excluded from keyword generation because of the 
frequency with which they can occur (that is, they are noise words).  If you are performing 
a keyword search and any of the keywords you entered are noise words, a warning is 
displayed in red below the Keyword(s) text box. 

13. Click the required button at the bottom of the form for the action that you want to take 
next.  Click the: 

� View Doc button, to open the View Document form. 

� Update button, to open the Maintain Contact form for a contact or the Add 
Conversation Entry form for a PAR. 

� Print/Extract All button, to open the Print/Email/Extract form, which enables you to 
request a printout, e-mail, or file extract of all of the results that were returned for this 
search.  For more details, see “Printing a Contact or PAR”, later in this chapter. 

Viewing the Colour Legend for the PAR Search Forms 
The contacts that are listed in the table on the PAR Search form are colour-coded to make 
identification easier. 

¾ To view the colour legend for the PAR Search forms 

� Right-click on the required contact line and then select the Legend command from the 
popup menu that is displayed.  The Legend for Search Form, shown in the following 
diagram, is then displayed.   
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Viewing a Contact or PAR 
As a client user, you can search for all contacts you have opened and for all PARs that have been 
opened by other clients. 

Note   You cannot view contacts for other clients or the contact details for a PAR that was 
opened by another client. 

¾ To view a contact or PAR 

1. Perform an appropriate search to meet your requirements.  For more details, see “Searching 
for Other Users’ Contacts and PARs”, earlier in this chapter. 

2. Select the contact or PAR whose details you want to view and then perform one of the 
following actions. 

� Click the View Doc button. 

� Right-click in the table and then select the View Document command from the popup 
menu that is displayed.   

The View Document form, shown in the following diagram, is then displayed. 
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Details of your selected contact or PAR are displayed on the form. 

Tips   The tabs on this form are coloured light blue (and are enabled) if there is 
information to be displayed on that sheet. 

A working set is also created with the entire previous search results copied to the working 
set.  This enables easy swapping between the contacts or PARs that matched your sort 
criteria, as well as freeing up the search form to perform other searches without losing the 
results of your last search. 

4. Depending on the status of your contact, the button below the pane on the Contact Details 
sheet performs one of the following operations. 

� If the contact is still open, the Update Contact button is displayed, which opens the 
Maintain Contact form.  For details, see “Updating a Contact”, earlier in this chapter. 

� If the contact is closed, the Reopen Contact button is displayed, which opens the 
Reopen Contact form.  For details, see “Reopening a Contact”, earlier in this chapter. 

� If the contact has been converted to a PAR, the Add Conversation button is 
displayed, which opens the Add Conversation Entry form.  For details, see “Adding a 
Conversation Entry”, earlier in this chapter. 

5. Use the buttons across the bottom of the form to perform the following functions. 

Button Enables you to… 
<< Prior Move to the prior contact or PAR in the working set. 
Next >> Move to the next contact or PAR in the working set. 
Print/Email/Extract Specify your output options on the Print/Email/Extract form. 

Printing a Contact or PAR 
As a client user, you can print contacts you have opened and PARs that have been opened by 
other clients. 

Note   The printout automatically suppresses the client details and the contact details for 
contacts that were opened by other clients. 

¾ To print a contact or PAR 

1. Select the contact or PAR that you want to print.  For details, see “Searching for Other 
Users’ Contacts and PARs” earlier in this chapter. 

2. Perform one of the following actions. 

� If you want to print, e-mail, or extract all of the documents returned by your search, 
click the Print/Extract All button on the Search form.   

� If you want to print, e-mail, or extract a specific document, open the View form for 
that document and then click the Print/Email/Extract button (on the View form).  
For more details, see “Viewing a Contact or PAR” earlier in this chapter.   
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The Print/Email/Extract form, shown in the following diagram, is then displayed, enabling 
you to select the options you want included in your output. 

 

Note   As a client user, you can select the External Use format only, which is 
automatically selected by default. 

3. In the Report Format group box, select the required option button; that is, Brief, Concise, 
or Full.  Alternatively, you can select your own options for what to include in the report, 
by selecting the appropriate option buttons in the Include in report group box, as follows. 

� Brief Description, which includes the brief description of the contact or PAR in the 
report output. 

� Par Details, which includes the detailed description of the PAR in the report output.  

� Interim Response, which includes the interim response for the PAR in the output. 
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� Formal Reply, which includes the formal reply for the PAR in the output. 

� Contact Details, which includes the Conversation Entries for the contact in the 
output.  This is automatically suppressed if the contact was not opened by you. 

4. Select the Print, Email, or File option button, to specify the required type of output.  The 
Print option is the default option.   

Note   The option buttons that you select determine the appearance of the Print Options 
group box and the buttons that are displayed at the bottom of the form. 

� If you select the Print option button, you can choose whether or not to preview the 
output.  To view a preview of the report, check the Print Preview check box.  

� If you select the Email option button, you can enter the e-mail address to which to 
deliver the output and select the format of the e-mail message you want to receive.   

The following diagram shows the fields that are displayed in the Print Options group 
box when you select the Email option button. 

 
� If you select the File option button, you can use the browse button (indicated by the 

… points of ellipsis) to select the file to create and the format of output you want to 
create. 

The following diagram shows the fields that are displayed in the Print Options group 
box when you select the File option button. 

 
5. When you have selected your required output type, click the required button at the bottom 

of the form.   

If the required report is output as: 

� A printed document, click the Print or Print & Close button, to produce the print 
output and optionally close the dialog on completion. 

� An e-mail message, click the Email or Email & Close button, to produce the e-mail 
message and optionally close the dialog on completion. 

� A file, click the Write File or Write File & Close button, to produce the file and 
optionally close the dialog on completion. 

Alternatively, close the form to cancel the output request and unload the 
Print/Email/Extract form. 



_________________________________ 
 

ParsysUG-2.3 

Appendix A    Technical Administration 

________________________________  
This appendix covers the following topics.   

� Installing the Parsys Application 

� Uninstalling JADE Thin Client and Parsys Application Software 

� Automatically Upgrading Software 

� Technical Overview 

� TCP/IP Port Numbers 

� Firewall and Internet Security 

� Troubleshooting 

� Presentation Clients Cannot Connect to the Application Server 

� Location of the JADE Initialisation File 
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Installing the Parsys Application 
Your contact person in the Jade Software Corporation Limited supplier company provides you 
with the Parsys InstallShield package (for example, as an e-mail attachment), which downloads 
and installs Parsys on your workstation and that of other users within your client company. 

The Parsys InstallShield package installs the JADE smart thin client (or JADE thin client) 
software and the Parsys application on to a presentation client workstation and configures it to 
connect to the managed server on which the Parsys database is located.   

You can then access the Parsys application on the managed server over a remote network 
connection (for example, from the Internet) by using a secure port.   

Note   You should exit from all Windows programs before you install the JADE thin client and 
Parsys application software, to avoid any sharing violations. 

You can run the InstallShield program directly, by opening it rather than saving it to disk when 
you are prompted to do so by the File Download message box.   

The installation process proceeds in stages, as follows. 

1. Initialises the jade.exe InstallShield program and then displays the Parsys Setup window. 

2. Displays the Welcome form, which welcomes you to the installation program.   

To continue the installation, click the Next > button.  Alternatively, click the Cancel button 
to exit from the set-up process.  If you click the Cancel button, the set-up program is 
closed.  After closing any conflicting applications, you can then restart the jade.exe set-up 
program.   

3. Enables you to select the destination location of the Parsys files, which are located by 
default in the C:\Program Files\Jade Software Corporation\Parsys directory on your 
presentation client workstation. 

To continue the installation, click the Next > button.  Alternatively, click the Browse 
button if you want to select another folder in which to install the Parsys software or click 
the Cancel button to exit from the set-up process.   

4. Runs the installation program and starts copying files.   

A progress bar is displayed as the files are copied and the software is installed. 

5. Displays the Setup Complete form, which informs you when the installation of the JADE 
thin client and Parsys application software is complete. 

To complete the set-up process, click the Finish button in the Setup Complete form.   

The Setup Complete form and the Setup window are then closed, and the Parsys icon is placed 
on your desktop.  

When the software has been installed, you can then initiate the Parsys application.   
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For details about: 

� Initiating the Parsys application, see “Signing On to the Parsys Application”, in Chapter 1.   

� Upgrading software on presentation clients, see “Automatically Upgrading Software”, later 
in this appendix.   

� Problems when connecting to Parsys on the managed server over a remote connection, see 
“Troubleshooting”, later in this appendix. 

Uninstalling JADE Thin Client and Parsys Application Software 
¾ To remove the JADE thin client and Parsys application software from your workstation 

1. Double-click the Add/Remove Programs icon in the Windows Control Panel. 

The Add/Remove Programs Properties form is then displayed. 

2. Select the PARSYS Web - cnwpucf application from the list of installed software 
programs that Windows can automatically remove. 

3. Click the Add/Remove button. 

The Confirm File Deletion message box is then displayed, prompting you to confirm that 
you want to completely remove the Parsys application and all of its components. 

4. Click the Yes button.  Alternatively, click the No button to abandon the software removal 
and return to the Add/Remove Programs Properties form. 

The UnInstallShield program is then initiated, which removes the JADE thin client and Parsys 
application software from your workstation and the Parsys application icon from your desktop. 

Automatically Upgrading Software 
On an infrequent basis, the JADE thin client and Parsys application software will need to be 
updated.  The software that is installed on each presentation client workstation detects when 
software on the managed server that contains the Parsys database has been updated.   

When you connect to the managed server, a comparison of the software versions is performed 
and one of the following actions is performed. 

� If there is a mismatch of any module when you initiate Parsys, the Thin Client Download 
form advises you that a new version of the thin client software must be downloaded to 
complete the request to initiate a Parsys work session.   

When you confirm that you want to proceed, the software is automatically downloaded 
from the server and the Smart Thin Client Download Install window is displayed. 

� If the versions of software on the managed server and the presentation client match or if the 
maximum number of downloads that is allowed is already in progress, the software 
download does not occur and the initiation of the Parsys application continues as normal. 

All installation operations are logged in the download.log file in the parsys\c_bin directory on 
your presentation client workstation.   
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If any file fails to copy, a message box advises you of this and prompts you to abort or retry the 
installation operation.  If you: 

� Abort the operation, the installation restores the appropriate files using the backup copy 
that it created previously and it then terminates.   

� Retry the operation, another attempt is made on the file operation, allowing you to deal 
with issues such as lack of available disk space.   

If you experience any difficulty with the automatic upgrade to a new version of software, you 
should be able to download the new software from the medium on which it was supplied (for 
example, from an e-mail attachment or a CD-ROM) to reinstall the software.  For details, see 
“Installing the Parsys Application”, earlier in this appendix. 

Technical Overview 
The JADE smart thin client mode in which the Parsys application runs moves most of the 
processing requirement from the presentation client workstation to the managed server that 
contains the database, reducing the amount of data that must be communicated and enabling the 
application to run over Intranets, dial-up lines, and the World Wide Web.   

The application logic (programs, or code) is executed on the application server and the only 
interaction with the presentation client is to notify the client of any Graphical User Interface 
(GUI) changes and to request information that is available only from that client.  This enables 
the software to have a smaller operational “footprint” on a presentation client workstation in 
terms of the required: 

� Resource (memory and disk) 

� Minimum workstation configuration 

� LAN or WAN requirement is significantly reduced 

Like most modern software, the JADE thin client uses Transmission Control Protocol / Internet 
Protocol (TCP/IP) for communications.  This enables it to be used across most networks 
including the most common of all: the Internet.   

To use the Internet, the JADE thin client software that is installed on the presentation client 
workstations has a specific TCP/IP host address or IP address and TCP/IP port number 
embedded within it.  This uniquely identifies the JADE system with which it is to communicate.   

TCP/IP Port Numbers 
Many people consider the Internet to consist only of the World Wide Web (WWW); that is, of 
Web sites that are viewed by using Web browsers such as Microsoft’s Internet Explorer or by 
Netscape Communicator.   

Web browsers use the HyperText Transport Protocol (HTTP) protocol and communicate over 
TCP/IP port number 80 by default.  There are also other common WWW protocols such as the 
secure HyperText Transport Protocol (HTTPS) that uses port number 443 by default.  These  
well-known port numbers are therefore usually ‘open’ through whatever network infrastructure a 
remote site may be using to access the Internet.   
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As security is of increasing importance on the Internet, most commercial organisations have 
routers, firewalls, or other software (for example, Black Ice Defender, Microsoft Proxy Server, 
or Wingate) that can be set up to deny TCP/IP access across the Internet to ports other than those 
that are commonly required.   

When applications run in JADE thin client mode, the presentation client uses port 443 for 
communication to the application server.  This port is used for communication for a number of 
reasons, as follows. 

� By default, most firewalls, proxy servers, and so on, are set up to allow this port through 
without much specific checking and without caching. 

� It is the standard port for encrypted traffic. 

� It allows for relatively simple checking for access through firewalls, and so on.  If a 
presentation client can browse to a number of secure Web sites using HTTPS (which also 
uses port 443), you can normally assume there is nothing in the way preventing access to 
the application server in JADE thin client mode. 

� Use of this port still allows restriction within firewalls, and so on.  If your network 
administrator does not want to allow global access out using port 443, it can be restricted 
by the source and destination IP address. 

In some situations this may not be allowed, in which case this port must be specifically 
opened.  Examples of this are where your network: 

� Does not allow browsing secure sites on the Internet. 

� Allows restricted access to sites on the Internet. 

Firewall and Internet Security 
If your organisation has installed a firewall between your workstation and the Internet, this can 
require special set-up for the JADE thin client.  The ideal type of firewall for use with JADE thin 
client software is one that is transparent; that is, one that makes it appear to the client software 
that it is directly connected to the Internet. 

Another type of firewall uses a communication protocol called socks.  As the JADE thin client 
does not currently support access to the Internet through this type of firewall, additional software 
needs to be installed on a workstation to allow access to the Internet.  You must contact your 
network provider or administrator for the necessary add-on software that support socks at the 
network stack level. 

The other major type of firewall is the proxy.  Proxies come in a wide variety of functionality.  
Highly functional ones like Microsoft Proxy Server implement additional security features such 
as authentication and redirection for load balancing.  The JADE thin client currently does not 
directly support redirection requiring any client action, and requires additional support software 
such as the Microsoft Proxy Client installed on the workstation.  The proxy server does not 
support the following as part of HTTP/1.0. 

� The CONNECT command 

� The Basic or Windows NT LAN Manager (NTLM) 
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Troubleshooting 
This section covers problems that may occur when you try to access the Parsys application 
running on the managed server. 

Presentation Clients Cannot Connect to the Application Server 
If your presentation client does not work after it has been configured, perform the following 
actions to resolve any connectivity issues, as appropriate. 

1. Attempt to connect to one of the following sites using your normal Web browser. 

� https://www.jadeworld.com/bin/jadehttp.dll?JWS&n=parinquiry 

� https://fnc.asbbank.co.nz 

� http://www.google.com/ 

If you cannot connect to any of these sites using your normal Web browser, perform the 
action described in step 13.  When the condition described in step 13 is resolved, restart the 
diagnostic process from this step (that is, step 1). 

Note   The network name that JADE uses to connect to the proxy must be resolvable to an 
Internet Protocol (IP) address by using either a Domain Name Server (DNS) or a local host 
file.  Consequently, the network name must not contain any prefixes (for example, 
https://). 

2. Request the actual proxy host name and port number settings for your LAN from your 
network administrator and then record these values in the following line. 
   Host name=______________________   Port number=______________ 

3. Modify the initialisation file (cnwpucf.ini, by default) for the Parsys application to reflect 
your host name (that is, the network name or Internet Protocol (IP) address of the proxy 
host) and port number of the proxy host. 

a. Right-click on the Parsys application icon on your desktop. 

b. Select the Properties command from the popup menu that is then displayed and then 
click the tab of the Shortcut sheet on the Properties form that is displayed.   

c. From the Target text box (that is, the command line), identify and record in the 
following space the path of the initialisation file specified in the ini= parameter (for 
example, ini=c:\Program Files\Jade Software 
Corporation\Parsys\c_bin\cnwpucf.ini). 
   Initialisation file path=___________________________________ 

See also “Location of the JADE Initialisation File”, later in this appendix. 

d. Initiate Windows Explorer (or File Manager, should you prefer), navigate to the 
directory you identified in step c, and then double-click on the .ini file.  

Your initialisation file is then displayed in a text editor (for example, Notepad). 

http://www.google.com/
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e. Locate the [JadeThinClient] section, and then specify the following parameters on 
individual lines, using the values that you recorded in step 2. 
   SSLProxyHost=network-name or proxy-host-IP-address 
   SSLProxyPort=proxy-host-port-number or proxy-host-port-name 

f. Save and then close your initialisation file. 

g. Start your JADE thin client Parsys application, by double-clicking on the application 
icon on your desktop. 

4. If you are still unable to access the Parsys application in JADE thin client mode and you 
are running Microsoft Proxy Server, you may have to install Microsoft Proxy Client on 
your desktop. 

Arrange for your network administrator to install Microsoft Proxy Client on your desktop.   

Caution    During this installation, consideration must be given to other proxy settings that 
could be impacted by installing Microsoft Proxy Client and programs that might be 
impacted by any proxy changes. 

5. If you are still unable to access the Parsys application in JADE thin client mode and you 
are running some other form of proxy server, your desktop might require changes. 

Arrange for your network administrator to review the proxy requirements and apply any 
changes that will enable the JADE thin client to communicate with the application using 
the Secure Sockets Layer (SSL) setting that you have declared in the initialisation file.  
(For more details, see step 3.) 

6. If the JADE thin client is still not working at this point, your network administrator should 
review the process documented in this section and attempt to identify what could be 
blocking the connectivity, for example: 

� Is port 443 open on the client router? 

� Does the host name resolve to the correct TCP/IP addresses and is it accessible? 

� Does the proxy server require user code and password authentication? 

7. Bearing in mind that it is your responsibility to correctly set up and configure your proxy 
server, other points to consider are:   

� The default settings may timeout an SSL connection if it has been inactive for 
approximately two minutes.   

You can increase the value of the DWORD registry setting (that is, 
HKLM\System\ControlSet001\Services\W3Proxy\Parameters\SocketIoTimeoutSecs) 
to a value larger than the value of the KeepAliveTime parameter in the 
[JadeAppServer] section of the JADE initialisation file on the application server, 
which is specified in minutes.   
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As the application server sends an 'are you there' type message to every presentation 
client each time the specified interval elapses, if the proxy server 
SocketIoTimeoutSecs parameter value is larger than the value of the 
KeepAliveTime parameter, the connection should stay up indefinitely.   

Note   The proxy server SocketIoTimeoutSecs parameter value is specified in 
seconds and the KeepAliveTime parameter value is specified in minutes. 

� The proxy server logging feature does reverse lookups on the IP address of the 
presentation client and application server.  If the proxy server cannot resolve these IP 
addresses, the start-up time for the presentation client could be as long as one to two 
minutes and the presentation client expects to connect within 45 seconds.  If the 
presentation client cannot do this, it raises an exception. 

You must ensure that the IP addresses used can be resolved to host names.  
Alternatively, you can turn this feature off.  You can use DNS or host files to achieve 
the reverse lookup, as required. 

The two points to consider listed in this step were located using the Microsoft Proxy 
version 2 on a workstation running under Windows 2000 Advanced Server. 

Location of the JADE Initialisation File 
Ensure that the command line for the JADE thin client Parsys application on each presentation 
client includes the ini= parameter.  (The Parsys InstallShield program sets this parameter 
automatically.) 

To check this: 

1. Select the Properties command from the popup menu that is displayed when you 
right-click on the Parsys application icon on the desktop. 

2. Click the tab of the Shortcut sheet on the Properties form that is then displayed.   

3. In the Target text box, ensure that the correct initialisation file and a valid path are 
specified in the ini= parameter (for example, ini=c:\program files\Jade Software 
Corporation\Parsys\c_bin\cnwpucf.ini). 

Caution   When SSL security is enabled, do not use the JADE default action of the presentation 
clients using the initialisation file in the binary directory. 

When running a JADE application, the JADE initialisation file is usually specified on the 
command line.  If a JADE initialisation file is not specified, JADE attempts to use the jade.ini 
file in the installation directory of jade.exe (that is, the bin directory) on the presentation client 
node. 

Caution   When running JADE thin client applications in multiuser mode, ensure that the 
TCP/IP port number specified in the jadapp.exe command line AppServerPort parameter is a 
different port number to that specified for the database server (for example, the jadrap.exe 
JADE Remote Node Access program).   
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If you have problems getting a presentation client to work after the JADE and Parsys application 
software has first been installed, the specified host address or the specified port number may not 
be visible from the presentation client workstation across the Internet.  There could be a number 
of reasons for such a problem.   

As the components and set-up of the computer network and Internet access are unique to each 
site, it will require investigation by your network support staff or by the supplier of the 
computer.   

To determine the application server host address and port number that the presentation client 
attempts to communicate with after the installation of the JADE thin client and Parsys 
application software, the user of the presentation client workstation performs the following 
actions. 

1. Right-click on the Parsys icon that is placed on your desktop during the installation 
process.   

2. Select the Properties command from the popup menu that is then displayed.   

The Parsys Properties form is then displayed. 

3. Click on the Shortcut tab, to display the Shortcut sheet.   

4. Click on the Target text box, locate and record the text appServer=, and then the text 
appServerPort=.  The text that immediately follows the equals signs (=) is the host 
address and TCP/IP port number, respectively. 
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